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1 Introduction

1.1 For Guidance

About the Release Letter
The Release Letter describes the main aspects of the TopSpin installation with the latest
developments. The complete installation is described in the TopSpin 4.0 Installation Guide.
This document is electronically available on the TopSpin DVD and at www.bruker.com. The
detailed information is also available directly in the Help menu of the installed TopSpin
program.
The Release Letter provides important information about improvements, deployments and
the history of the Bruker software.

Target Audience
The Bruker Software Release Letter, in this case the Release Letter for TopSpin 4.0.5,
supports all Bruker users who work with Bruker software products. In order to communicate
all improvements as quickly as possible, Bruker routinely provides the Release Letter for all
users.

How to get the Release Letter
The Release Letter is only available electronically on the TopSpin DVD, in Acrobat Reader
(PDF) format and as html. The Release letter is not available as a hard copy. This allows
Bruker to provide an up-to-date version of the Release Letter. The latest version of the
Release Letter is also provided on the Bruker Web Server:
http://www.bruker.com/service/information-communication/user-manuals/nmr.html
Please note that a login for the Bruker website is needed to show this document.
Please note furthermore that under macOS the Release Letter will be shown in PDF format.

Release Letter Conventions
The Release Letter utilizes different script types in order to make selected text more
transparent and explicable for users. Please note that the Release Letter contains the
following conventions:
Bold - commands to be entered from the keyboard or to be clicked on with the mouse
Italic - file names, program messages (e. g. error messages) and web addresses

1.2 Safety Regulations
In order to work safely in laboratories with NMR-spectrometers all users have to follow the
safety regulations for magnetic, electrical, cryogenic and chemical safety. For detailed
information please refer to the safety instructions in the AVANCE Systems General Safety
Considerations Manual (Z31836) provided on the BASH DVD. This manual is available in
several different languages.

http://www.bruker.com/
http://www.bruker.com/service/information-communication/user-manuals/nmr.html
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2 TopSpin - Basics

2.1 About TopSpin
TopSpin 4.0.5 is a minor update of TopSpin program package containing many
improvements, new and useful features and bug fixes.

TopSpin 4.0.5 has been tested and released only for AVANCE NEO
spectrometers.

Older spectrometer types are not supported and TopSpin 4.0.5 cannot be used on them for
data acquisition. For continued support of these products please refer to updated versions of
TopSpin 3.

2.2 License Requirements
TopSpin 4.0.5 comes as a full program version on DVD and requires a TopSpin 4 license.
Please contact your local Bruker representative for license order and more details. All
addresses in detail are listed in Contact [} 47].

2.3 TopSpin Program Versions
The TopSpin 4.0.5 DVD contains the following program versions:

• TopSpin 4.0.5
• IconNMR 5.1.4
• NMR Guide 4.4

The following programs are part of the TopSpin 4.0.5 DVD content, but please note that they
must be licensed separately in each case:

• AMIX 3.9.15
• Spectra Base 1-1-2

(Please note that the Spectra Base is only available with AMIX and the different license
types (belonging to the pH-value) and the updates must be licensed separately.)

• CMC-se 2.5.5
• CMC-assist 2.11
• InsightMRTM 1.1.3 (for Windows and Linux)
• DynamicsCenter 2.5 (Protein Dynamics)

Please note that for the mac a reduced collection is available.
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2.4 Hardware Requirements

2.4.1 PC Hardware

To run TopSpin 4.0.5 a state of the art computer should be used. Bruker recommends and
delivers the following PC:

• HP z440, Intel Xeon Quad Core E5-1620v4 / 3.50GHz / 10MB Cache
• Memory: 16GB (2x 8GB) DDR4-2400 ECC, 8x memory slots (2x used)
• Video Card: Graphic adapter: Graphic adapter NVIDIA Quadro K620, 2GB
• Network adapters: 1x Intel I218LM PCIe on Board 10/100/1000 Mbits/s (SPECT),

1x Intel Ethernet I210AT PCIe GbE 10/100/1000 MBits/s (NET)
• Hard Disc: 2TByte, 3Gb/s, NCQ, SATA, 7200rpm
• Optical Storage: Slim SATA SuperMulti DVD writer
• 3 button mouse or wheel mouse

2.4.2 Apple Computers

• MacBook, iMac or MacMini (state of the art) with Intel CPU
• CPU must be capable of executing 64bit instructions
• Apple mouse or any 3 button or wheel mouse

2.5 Spectrometer Hardware Requirements
TopSpin 4.0.5 runs on any AVANCE NEO spectrometer.
For upgrade possibilities of your spectrometer with TopSpin 4.0.5, please check with your
local Bruker office.

2.6 Supported Operating Systems
TopSpin 4.0.5 on spectrometer computers is supported for:

• Windows 10 (64bit)
• Windows 7 (64 bit)
• CentOS 7 (64 bit) (Please note: The minimum required CentOS7 Version is 7.1)

All operating system updates (hot fixes and service packs) at the time TopSpin 4.0.5 was
released have been tested and are supported.
TopSpin 4.0.5 on data stations is supported for:

• Windows 10 (64 bit)
• Windows 7 (64 bit)
• CentOS 7 (64 bit) (Please note: The minimum required CentOS7 Version is 7.1)
• Apple macOS X 10.12 or higher

Although not officially supported by Bruker, users reported that TopSpin is also running and is
used for data processing on other Linux systems, including Ubuntu-17.10, Ubuntu-16.04,
Debian-9, Fedora-27, openSUSE-Leap 42.3 and Linux Mint 18.3. You will find further
information in the Bruker Knowledge Base Article #14407.
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2.7 Software Requirements

2.7.1 Under Windows

All AVANCE NEO spectrometers do not need any further software or equipment to install
TopSpin.

2.7.2 Under Linux

All AVANCE NEO spectrometers do not need any further software or equipment to install
TopSpin.

2.7.3 Under macOS

No additional software is required to run TopSpin as data station.



TopSpin - Basics

8 / 50 H90088TR4-05_1_001



TopSpin Installation

H90088TR4-05_1_001 9 / 50

3 TopSpin Installation

3.1 Installation on Windows and Linux
Please note that TopSpin 4.0.5 comes as a full program DVD and, as such, requires a DVD
device for installation.
Alternatively, the full TopSpin Installer can be downloaded from this web page:
http://www.bruker.com/service/support-upgrades/software-downloads/nmr.html
Please note: You need a login to access this section. If you haven’t registered yet, please
register here:
https://www.bruker.com/about-us/register.html
The installation procedure is described in the Installation Guide for Windows, Linux and
macOS. This document is available electronically on the TopSpin DVD and on
www.bruker.com.
If you have already a previous TopSpin version installed, then install the TopSpin 4.0.5
program in a different directory. This will allow you to utilize and enjoy the new features
without affecting your current installation.

3.2 Using a Previous Configuration (TopSpin) on Windows and
Linux
TopSpin 4.0.5 usually replaces a previous version of TopSpin and, normally, you want to
keep the existing configuration. The installation program automatically detects previous
installations of TopSpin, prompts you to select one and then copies its configuration files. If
multiple previous installations are found, you can choose which configuration you want to
copy to the current installation.
After the installation has finished, you can simply start TopSpin and run cf, selecting the
copied configuration, and run expinstall.
If you have chosen not to copy a previous configuration, you can still do that after the
installation has finished with the TopSpin command nmr_save. For more information on the
command nmr_save, enter:
help nmr_save
or refer to the Installation Guide.

3.3 Installation on macOS
Please note, that the Topspin installation on macOS selects the installation folder
automatically.
Different versions always use different installation folders. The expinstall command is also
invoked automatically.
The spectrometer configuration is not copied, because macOS version of TopSpin is always
configured as a data station. You may still use the nmr_save command to transfer private
files (waveforms, pulseprograms) between different TopSpin installations.

http://www.bruker.com/service/support-upgrades/software-downloads/nmr.html
https://www.bruker.com/about-us/register.html
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4 New Features

4.1 Support of TRX ECL 02
TopSpin 4.0.5 offers full support of TRX ECL 02 boards.
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5 TopSpin Licenses
A license for Bruker software can be ordered from the Bruker website. Just go to
https://www.bruker.com/nmr_license_requests.html
and fill out the request form.
Bruker BioSpin offers the following license types for TopSpin:

license type contents

Full

Acquisition, Processing, Automation (IconNMR),
Plotting, Simulation and NMR-GUIDE

run of validity: 15 years

Demo

Acquisition, Processing, Automation (IconNMR),
Plotting, Simulation and NMR-GUIDE

run of validity: 3 months

free of charge

Processing-Only

Processing,
Plotting, Simulation and NMR-GUIDE

run of validity: 15 years

Student and
Academia

Processing,
Plotting, Simulation and NMR-GUIDE

run of validity: 15 years

free of charge

In order to provide students, researchers and teachers with unlimited access to the best tools
for off-line NMR processing, Bruker is making their market leading NMR processing software
TopSpin available free of charge for all academic users. If you are eligible to use the free
license you can download and install the TopSpin software from the Bruker website at the
following address:
https://www.bruker.com/service/support-upgrades/software-downloads/nmr.html
On the same web page you can request your free license activation ticket for TopSpin 4.0.5.
Or install TopSpin on your system first and start it immediately. The license management
dialogue will show up and guide you to the correct web page for requesting a ticket.

https://www.bruker-biospin.com/nmr_license_requests.html
https://www.bruker.com/nmr_license_requests.html
https://www.bruker.com/service/support-upgrades/software-downloads/nmr.html
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6 History of Changes

6.1 TopSpin 3.5
All changes provided with TopSpin 3.5 are summarized in the release letter of TopSpin 3.5.
All release letters for older versions of TopSpin can be found here:
https://www.bruker.com/service/information-communication/user-manuals/nmr/general.html
Please note: You need a login to access this section. If you haven’t registered yet, please
register here:
https://www.bruker.com/about-us/register.html

6.2 TopSpin 4.0.1

6.2.1 General

6.2.1.1 New Licensing System: CodeMeter

TopSpin uses the new “CodeMeter” license management. A license for Bruker software can
be ordered from the Bruker website. Just go to https://www.bruker.com/
nmr_license_requests.html and fill out the request form. License department will process the
order details and generate an “activation ticket” and provide it to the customer. A ticket
consists of a 25 character code like e.g.:
PH3T4-9D9U9-FNSGP-J9FXP-TTNXC
This code works as an access key to the purchased license package. It authorizes the
customer to assign the license package to a computer of personal choice.
Install the software product on the computer system. During installation you may also be
requested to install the package “CodeMeter Runtime”. This is the component of the license
management system. Most installation routines will perform this task automatically.
A Free TopSpin Evaluation license can be ordered on the following web page:
https://www.bruker.com/service/support-upgrades/software-downloads/nmr/free-topspin-
processing/topspin-demo-licences-generation.html
A Free TopSpin Processing license for Academia can be ordered on the following web page:
https://www.bruker.com/service/support-upgrades/software-downloads/nmr/free-topspin-
processing/nmr-topspin-license-for-academia.html
For further Information please look up the CodeMeter License Management User Manual.

The Linux version of the CodeMeter runtime delivered with TopSpin comes as an RPM
package and thus can only be installed on RPM based distributions like Red Hat (CentOS,
Fedora) or Suse. If you use a different, not directly supported, distribution (Debian, Ubuntu,
…), please download the CodeMeter Runtime here:
https://www.wibu.com/downloads-user-software.html
and follow the given installation details.

https://www.bruker.com/service/information-communication/user-manuals/nmr/general.html
https://www.bruker.com/about-us/register.html
https://www.bruker.com/nmr_license_requests.html
https://www.bruker.com/nmr_license_requests.html
https://www.bruker.com/service/support-upgrades/software-downloads/nmr/free-topspin-processing/topspin-demo-licences-generation.html
https://www.bruker.com/service/support-upgrades/software-downloads/nmr/free-topspin-processing/topspin-demo-licences-generation.html
https://www.bruker.com/service/support-upgrades/software-downloads/nmr/free-topspin-processing/nmr-topspin-license-for-academia.html
https://www.bruker.com/service/support-upgrades/software-downloads/nmr/free-topspin-processing/nmr-topspin-license-for-academia.html
https://www.wibu.com/downloads-user-software.html
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6.2.1.2 TopSpin starts without license

TopSpin can start even without a valid license, then informing the user with an interactive
dialogue about available licensing options.

Additional Demo- and Academia-Licenses can be ordered free of charge from the Bruker
Website:
https://www.bruker.com/service/support-upgrades/license-requests/nmr-license-requests.html

6.2.1.3 Spectrometer Control

The spectrometer is turned on / off with TopSpin command pdudisp.

6.2.1.4 64bit Environment

Topspin 4.0 on Linux is compiled for 64bit environment and needs no 32bit runtime
environment anymore.

6.2.1.5 Changes in Software Architecture

Concerning the architecture of the software, the major difference to AVANCE III is that the
computer embedded in the spectrometer (AVANCE III: IPSO, AVANCE NEO: EPU) is much
more powerful and now hosts all of the software modules used for acquisition as well as the
configuration files (i.e. the conf/instr/spect folder) of the spectrometer.
The latter is mirrored to a folder <TSHOME>/conf/instr/remote_spect on the workstation for
the sake of transparency. This means that changing configuration data manually with an
external editor will not affect the actual configuration on the spectrometer, but as long as the
user interface of TopSpin is used the configuration is synchronized automatically and the
changes will take effect as expected.

https://www.bruker.com/service/support-upgrades/license-requests/nmr-license-requests.html
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6.2.1.6 NMRSim integral part of TopSpin

Bruker simulation package NMR-Sim is now an integral part of TopSpin, the corresponding
installer option was therefore removed. All NMR-Sim related functions (simulation, pulse
program display…) are still available, however NMR-Sim cannot be started as standalone
application.

6.2.1.7 Command plot0 temporarily not available

The legacy standalone plot editor as launched by command plot0 is temporarily not available
in this release. A solution is in preparation for a next minor version.

6.2.2 Acquisition

6.2.2.1 Multi-dimensional acquisition (ser-Files) written as 64 bit values

FIDs for multi-dimensional acquisitions (ser-files) are now written as 64 bit values compared
to 32bit in older versions of topspin.
As a consequence, it is now not directly possible anymore to process those 64bit ser-files
with TopSpin 3.5 or older without converting the data back to 32bit format.
In order to keep compatibility, this conversion is currently automatically performed in TopSpin
4.0 after each acquisition but can be deactivated in the Preferences-menu:

In case you need to optimize acquisition speed or keep GLP-compliance this checkbox
should be deactivated.
Even after the acquisition it is always possible to convert ser-files from 64bit to 32bit and back
using the au-programs sertoint and sertodouble.

6.2.2.2 cf: combo-box asking for magnet polarity

In cf, there is now a combo box that optionally allows to make the polarity of the magnet
known to the software. This value is later on used by the BSMS to determine the direction of
its shim currents.

6.2.2.3 AQ_mod

The acquisition modes qf, qsim and qseq are obsolete with AVANCE NEO due to the
increased performance of the receiver hardware. AQ_mod=DQD can now be used over the
whole range of possible sweep widths.

6.2.2.4 What is new in WaveMaker

New parameter (d1) allows arbitrary positioning of shaped pulses when constructing complex
waveforms, such as composite adiabatic pulses, CHORUS, ABSTRUSE and similar.
Optimized notch pulses often used in bio-molecular NMR experiments, such as SOFAST and
BEST type experiments automatically adjust the notch position depending on the flipangle
variations.
New arrivals in the WaveMaker shape library – 25 new shapes have been added including
five BIP pulses (inversion), e-family pulses (excitation) and Q5sebop (excitation).
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6.2.2.5 Command wobbt replaced

The topspin command wobbt has been replaced by wobb thick.

6.2.2.6 New MAS3-firmware

A new firmware for MAS3 containing significant improvements has been released (available
in <TopspinHome>/conf/instr/servtool/mas3).

6.2.3 Processing

6.2.3.1 2D/nD processing with FnILOOP

Multidimensional AVANCE NEO data sets contain a new acquisition status parameter
FnILOOP in each non acquisition dimension. This parameter describes the number of inner
loops in this dimension. If one of the FnILOOP status parameters is > 1 the split AU program
specified in the pulseprogram must be applied to separate the inner loops.
In contrast to pre AVANCE NEO data sets the acquisition status parameter TD in non
acquisition dimensions no longer contains the number of inner loops and therefore is not
reduced by the split AU programs.

6.2.4 Automation

6.2.4.1 IconNMR 5.1

User Manager Update Experiment List Tool
• Easily discover and add new experiments contained within this TopSpin release
• Search for experiments in the user’s experiment list

General Automation
• Handle Multi-Receive Experiments simply as composite experiments
• Suggest which sample position to use next at login time
• Dedicated SampleCase automation driver
• Improved configuration user interface experience
• Show the sample temperature in the automation window status line (also available in

current TopSpin 3.5 Versions)
• Heat individual SampleCase samples as necessary just in time before they are inserted

(also available in current TopSpin 3.5 Versions)
• Spreadsheet Import uses flexible column names (also available in current TopSpin 3.5

Versions)

6.2.5 Pulse Programming

6.2.5.1 Command dccorr obsolete

Command dccorr is obsolete because the correction is automatically done by the hardware.
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6.2.5.2 Command spf obsolete

Command spf is no longer needed, because the complete functionality is covered by
command sp.

6.2.5.3 Command anavpt obsolete

Command anavpt is obsolete, because there is no analogue mode anymore.

6.2.5.4 Pulse Program: New RTP Macros

Most of the RTP macros used in the pulse program had to be changed to be in accordance
with the architecture of AVANCE NEO, especially those that are used for explicit dwell
generation. In rare cases this will cause compilation errors in user-defined pulse programs.
Please refer to the Pulse Programming Manual for further details.

6.2.5.5 External Dwell Pulses

The go and adc statements instruct the digitizer to acquire the desired number of data points
with a rate given by the dwell time. The dwell pulse (only a short dwell pulse is necessary to
acquire a complete scan) is generated by the TRX which is dedicated to the observe channel.
This is the meaning of the macro DWELL_GEN which evaluates to the statement:
aq cpdngs17:f1

Please note that DWL_CLK_ON/DWL_CLK_OFF is no longer used.
For further information please look up Pulse Programming Manual section 10.1.8 “External
Dwell Pulses”.

6.2.5.6 Parameter DIGMOD

With AVANCE NEO, all incoming FIDs are now digitally filtered, therefore the parameter
DIGMOD is now always set to ‘digital’, and the alternative ‘analog’ has become obsolete.
Nevertheless, it is of course still possible to acquire single data points explicitly. Please refer
to the Pulse Programming Manual for further details.

6.2.5.7 Compile-time variable grpdly

The group delay is available in the pulseprogram as compile-time variable grpdly.
It is defined as number of complex points, i.e. a group delay of 78 means that the first 156
points of the FID are affected by the length of the filter pipeline.
For further information please look up the Pulse Programming User Manual.

6.2.6 General User Interface

The TopSpin 4 graphical user interface has been modernized and rearranged. A primary goal
of this redesign has been to provide the familiar functionality and commands with improved
ergonomy and efficiency for daily use. Some adjustments and additions have been made for
the AVANCE NEO spectrometer series. Please have a look at the new Workplace Tour
found in the Help menu (click on the question mark in the top menu bar), and also the
following sections.
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6.2.6.1 Window Switcher - Switch through open Data and Apps

To switch through open datasets use the overview in the Browser Panel or via menu button.
Close all or the current Window in the overview. It is also possible to select multiple datasets
while pressing CTRL and click datasets in the overview. Close selected window or open it in
a multiple display overview.
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Window Switcher Browser

Window Switcher Button

6.2.6.2 Quick access to change View Options

Get a quick access to switch the perspective (e.g. full screen), compare open datasets or
change spectra view options in the Change View Options menu:

6.2.6.3 Quick access to Publish Options

Share your work from every point in your working routine with your colleagues, send to
printer, export in optional data formats or “more” (e.g. copy and paste, send via email or use
shared directories):

6.2.6.4 Quick Access to Setup Preferences

For all changes in the TopSpin appearance use the global Setup preferences button:
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6.2.6.5 New Spectra axes scrolling and shifting behavior

New feature in the spectrum axis allows intuitive scrolling through the spectrum.
• Single Clicks on the end regions of the axes or a click and dragging the mouse shift

through the axes depending on the mouse position (see the following figure).
• Double click in the middle of the spectra axes switch to full axes region.
• Double click in the middle of the spectra itself maximize all axes regions

6.2.6.6 New command line and status acquisition bar features

The line underneath the main TopSpin data window now contains three areas. The left area
is the command area where commands can be entered, like zg. The middle area contains the
dataset information. The right area is the status report area where progress on running
commands is being displayed.
The acquisition status bar contains the new Spectrometer Status area to turn the
spectrometer on and off. This functionality is also available through the Manage menu or the
command pdudisp.
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6.2.7 GLP Operation

During the installation of TopSpin, the new feature Central Audit File may be selected. This
initiates the logging of all TopSpin related actions into one central audit file. This file is always
appended to and never overwritten.

6.2.8 Analysis

6.2.8.1 Fragment Based Screening (FBS)

In TopSpin 4.0 we present a novel software tool for interactive analysis of NMR based
screening data that is embedded within the software suite from Bruker, which now supports
the workflow from data acquisition and processing to data analysis and hit reporting in the
field of Fragment Based Lead Discovery (FBLD). The three most popular NMR experiments
for fragment screening, Saturation Transfer Difference (STD), waterLOGSY, and relaxation
based methods, are automatically identified. Reference 1D 1H spectra of fragments are
recognized by unique identifiers of the employed molecules and presented to the user in
multi-display mode together with the screening spectra. Hits are visually identified and
selected by mouse click on the display. The results are stored in a project file that is
automatically loaded on program launch. The tool allows the most flexible implementation in
individual laboratory environments with few restrictions with regard to data storage and
preparation; for instance, no databases need to be prepared. In addition, automation routines
for NMR based screening experiments that are part of the latest Topspin release are
presented.
Please note that the FBS demo datasets can be downloaded from Bruker dropbox under the
following link: https://www.dropbox.com/s/v8y8hw3kxolly0m/demo_data_TS35pl7.zip?dl=0
For further information look up the documentation „Fragment Based Screening Analysis
Suite“ reachable with command help fbs.

6.3 TopSpin 4.0.2

6.3.1 Bug Fixes

The following topics describe the major fixes which come with TopSpin 4.0.2.
The topics are named by item numbers, referring to the Bruker knowledge base. For detailed
information about the different items, please look up the Bruker knowledge base. The Bruker
knowledge base can be found on the Bruker Web Server under the following address:
http://www.bruker.com/bkb_access.html?&no_cache=1

Please note: You need a login to access this section. If you haven’t registered yet, please
register here:
https://www.bruker.com/about-us/register.html
If you are already connected to the internet and if you have access to the Bruker knowledge
base, you can then open the respective item by entering the item number in the appearing
window.

• Item # 14287 rga fails: No valid RG found after 18 steps

• Item # 14266 Logging in to TopSpin with internal user account 5 times unexpected
behavior

https://www.dropbox.com/s/v8y8hw3kxolly0m/demo_data_TS35pl7.zip?dl=0
http://www.bruker-biospin.com/bkb_access.html?&amp;amp%253Bamp%253Bno_cache=1
http://www.bruker.com/bkb_access.html?&no_cache=1
https://www.bruker.com/about-us/register.html
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• Item # 14257 Error: bad command invoke: must be bbox, cget, …
• Item # 14252 AUDIT command not working using dataset lists

• Item # 14251 19F routing problems with AVNEO

• Item # 14243 Barcode: Samples beyond row#99 in “Experiment Table” not wasted

• Item # 14233 Pulse programming: incrementing shape lists does not work

6.3.2 New Features

6.3.2.1 General

TopSpin is free for academic use since version 3.5. Academic users can create their personal
license ticket after login into the Bruker web pages and activate their installation. When
TopSpin has been started with an free Academic license, this is indicated in the title bar of
the main application window.
TopSpin informs the user by an information window upon application startup if the currently
used license will expire in less than 30 days. This should give the user sufficient time for a
renewal before the product license finally expires.

6.3.2.2 Acquisition

In the ‘set’ menu, one can now activate an automatic scaling of the FID by RG and/or NS.
The options are “Scale acquired FID according to receiver gain” and “Scale acquired FID
according to number of scans”.
Please note that above options may be an issue if you run ERETIC experiments, or if you use
data sets with scaled RG in older versions of TopSpin. In these cases automatic scaling must
be deactivated.
Independent of the scaling options set in the user interface, you can always run an
acquisition without those scaling options by starting zg with the command line parameters “–
forceNeverDivideByRg” and/or “–forceNeverDivideByNs”, respectively.
There is also a boolean value in the status acquisition parameters file (acqus) indicating
whether the respective option has been used (scaleByRG and scaleByNS).
The new cortab files have a different nomenclature and are not backwards compatible (but
old cortab files are forward compatible). Old cortab files are automatically copied into the new
format (you have to start ‘cortab’ once to run this procedure) so that they can be used with all
versions of TopSpin 4.

Please note that you still can use the old cortab files without problems.

The userA1 – userA5 parameters can be used to hold complete WaveMaker waveform
definitions avoiding the need to make changes in the pulse program comments area. In that
way automatic pulse shaping can be applied to the sequences in the standard Bruker pulse
program library.
New parameter (d1) allows arbitrary positioning of shaped pulses when constructing complex
waveforms, such as composite adiabatic pulses, CHORUS, ABSTRUSE and similar.
Optimized notch pulses often used in bio-molecular NMR experiments, such as SOFAST and
BEST type experiments automatically adjust the notch position depending on the flipangle
variations.
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New arrivals in the WaveMaker shape library – 25 new shapes have been added including
five BIP pulses (inversion), e-family pulses (excitation) and Q5sebop (excitation).

6.3.2.3 Automation

• Option to hide the sref message: “reference peak not found default calibration done” from
Preceding Experiments->Remarks

• Assure-SST allows for setting of the Shim routine individually for all SST experiments
• New Dual Receive Composite Experiment Definitions: COSY, HSQC and TOCSY
• New languages available: Chinese, French, Italian, Korean, Portuguese

6.3.2.4 Pulse Programming

• Bracket operator for lists now working (e.g. powerList[2]:f1)
• Shape lists now available (list<shape>)
• Modification of RG now possible from within the pulse program using a list<receiverGain>

Please refer to the Pulse Programming Manual for further details (“Receiver Gain Lists”).

6.3.2.5 General User Interface

The acquisition status parameter INSTRUM now contains the spectrometer description from
cf instead of always "spect". With AVANCE NEO the Spectrometer Description can be edited
during cf.

Command edcstm offers the possibility to edit “System Type”.
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The Spectrometer Description is shown in plot legend.
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Some flow-bar menus offer a default action when the menu button is clicked directly. This
default action is now also shown in the drop-down menu again for convenience and more
consistent navigation.
The integrated search functionality in the data browser tab allows to quickly filter for certain
data sets. However, the traditional Find dialog had become hidden in the menu system and is
now offered again via the 'Find' button directly in the search filter box. The Find dialog now
includes the field SPECTYP which relates to the value of this parameter in the data sets
searched. Additionally, the keyboard shortcut Ctrl+F can be used to bring up this dialog.

6.3.2.6 GxP Operation

The system administrator can configure more restraints for internal users in order to enhance
compliance with GxP regulations:

• Password complexity can be set. An option is available that requires passwords to include
at least one character out of each group of characters such as lowercase, uppercase,
digit.

• Password aging: It is possible to define that passwords expire after a certain number of
days. An expired password needs to be renewed by the user at next occasion when a
user authentication is requested by the software. The new password must not be identical
to the previous password. It is possible to disable password expiration.
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• The default minimum password length is 8 characters when new passwords are set. The
minimum password length can be configured. For existing internal users it is sufficient to
maintain that condition first when a new password is set.

• Internal accounts can be set to “disabled” or “enabled” instead of being deleted
immediately. “Remove” operation proposes to use “Disable” instead.

The command lockdataset had been introduced with TopSpin 3.5pl7 for Windows only and
is available on command line and from the "Security" flow menu. This functionality is now
available for both Windows and Linux environments. Under Linux, execution of lockdataset
will remove all write permissions from the current dataset including all existing PROCNO
directories. It prohibits adding new PROCNO directories since the permission concept of the
Unix file system enforces this restriction. The implementation for Windows allows to add new
PROCNOs even if the dataset has been locked.
Additionally, a command unlockdataset is offered now which allows to take back the lock
state. This command requests the user to provide the NMR Administration password in order
to authorize the action. The command is not available in the flow menus and can only be
entered at the command line. Customers who disallow this functionality in their laboratory's
standard operating procedures should remove the AU program 'unlockdataset' from an
installation.

6.3.2.7 Plot Editor

The legacy stand-alone plot editor is available again (it was missing in TopSpin 4.0.1) and
can be launched with the command 'plot0' for Windows and Linux. Please note the external
editor is only provided for convenience and will not contain further developments as found in
the integrated Plot tab.
When the Plot tab is selected, data sets can be dragged from the data browser tree to the
plot area. Data objects for these data sets are added to the actual layout view then. The
dataset portfolio is updated automatically as required. 1D data sets can be added to 1D
layouts. This allows to quickly create an overview of several 1D experiments. 1D data sets
dragged to 2D layouts will automatically be used as projections of the first 2D object.
Dragging 2D datasets to 2D layouts is not supported.

6.3.2.8 AU programming

• The new AU program measureHelev triggers a measurement of the Helium level. 
In addition, the He-log-file can then be copied from EPU to workstation using the AU
program getheliumlog.

• AU program bt_calibrate_o1 now working.

6.4 TopSpin 4.0.3

6.4.1 Bug Fixes

The following topics describe the major fixes which come with TopSpin 4.0.3.
The topics are named by item numbers, referring to the Bruker knowledge base. For detailed
information about the different items, please look up the Bruker knowledge base. The Bruker
knowledge base can be found on the Bruker Web Server under the following address:
http://www.bruker.com/bkb_access.html?&no_cache=1

Please note: You need a login to access this section. If you haven’t registered yet, please
register here:
https://www.bruker.com/about-us/register.html

http://www.bruker-biospin.com/bkb_access.html?&amp;amp%253Bamp%253Bno_cache=1
http://www.bruker.com/bkb_access.html?&no_cache=1
https://www.bruker.com/about-us/register.html
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If you are already connected to the internet and if you have access to the Bruker knowledge
base, you can then open the respective item by entering the item number in the appearing
window.

• Item # 14380 Eretic output is not correct for low concentrated samples

• Item # 14379 Export pf PDF file fails

• Item # 14248 Multiple buffer acquisition doesn't work for some TD values

6.4.2 New Features

6.4.2.1 General

6.4.2.2 User Interface

The data directories in the Data Browser can be edited now.
Invoking “Edit Selected Data Dir” in the data browser popup menu opens a dialog allowing
to modify the data folder and its alias name.

Topspin flow menus are now also available in Chinese translation.



History of Changes

30 / 50 H90088TR4-05_1_001

The desired translation (currently English and Chinese) may be selected from the Topspin
Preferences dialog.

Applications running on high resolution (4k) displays require often larger fonts and icon.
The TopSpin Prefrences dialog allows to select one of the predefined configurations
matching typical screen resolutions.

The dialog offering options for license requests and management can be opened at any time
now by choosing Bruker License from the Help menu (question mark). Legal information
about involved licenses is accessible by the menu entry 3rd party licenses.
The display of TopSpin’s Command History (menu Manage | Commands) merges several
protocol files into one single track. The included sources can be selected individually now.
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6.4.2.3 System Support

6.4.2.4 Acquisition

• The wvm command is now available for automation. The ‘quiet’ option, -q works in the
same way as the auto-setup option, -a, except it does not activate the ased command
making the wvm command compliant with the automation requirements and the Icon
NMR protocols.

• The userA1-userA5 parameters can now be used to define waveforms (sp, gp, cpd)
exactly in the same way as they are defined in the comments section of the pulse
programs. This avoids the need for modifying the pulse programs and allows re-definition
of shaped pulses for experiments in the standard Bruker pulse program library. The shape
definitions are saved with the data (parameter) sets and avoid a potential confusion if the
pulse program is changed at a later stage.

• The userA1-userA5 parameters can also be used to re-define the shape functions. For
instance, the eburp1(450 Hz) shape can be defined as userA1(450 Hz) with the userA1
parameter set to eburp1. A simple change of the userA1 parameter then allows creating
the same shaped pulse or decoupling waveform, but with a different shape. This provides
more flexibility to the experiment setup.

• The –b option activates the Bloch simulator and shows the excitation profile of the newly
created shape(s). In applications with several shapes the shape number can be specified,
e.g. wvm –b 3 (see figure below).

Figure 6.1: The wvm-b option in WaveMaker shows the excitation profile of the shaped pulse(s).
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With this latest version of TopSolids you can use the command topsolids to open the
interface directly from the TopSpin command line.
We introduce a flow bar navigation, which is divided into applications for protein and material
(= non-protein) samples. In this context, we re-arranged the “Materials” part of TopSolids into
three subdivisions and added new features:
1. “1D Direct Excitation”
2. “1D/2D CP-based Experiments”
3. “1D/2D MQMAS”
Though these new flow bars work independently, optimized parameters are shared between
the different modules if needed. Furthermore, for many steps you can decide to optimize
parameters on a standard sample first or directly on your sample of interest.
We included the setup of a 2D H-X Hetcor experiment in the “1D/2D CP-based Experiments”.
TopSolids automatically checks if the needed cross polarization parameters have been
optimized already. If not, it will directly start the optimization, before continuing with the 2D
setup.
To avoid offset errors within the automation, the step “Shimming & Referencing” in the “Probe
Setup” flow bar is now mandatory for each new TopSolids project.
For security reasons, the import of previous TopSolids Parameter data files
(“topsolidsPars.xml”) is allowed if both projects have been create with the same version of
TopSolids.
The step “ 13C 90deg Pulse Optimization” in the “Probe Setup” flow bar is up and running
again.
New option for rga to set a fixed delay: For example, “rga –setD0=0.02” sets d0 to 20msec.
In this way you could head for the row with maximum intensity in your nD-experiment.
Currently when the sample rotation is active, it stays active when ejecting the sample. This
can lead to problems when the next sample is inserted. It can happen that this sample does
not fully fall down into the probe because of the still active sample rotation. Now the sample
rotation is switched off before the sample is changed.

6.4.2.5 Processing

Parameter SPECTYP specifies the content of the processed data, is used in several
application like CMC-se or Fragment Based Screening to identify spectra like HSQC or
COSY and Topspin now always updates the status value when the foreground value
changed.
Therefore it is not anymore necessary to change the status value as described in the CMC-se
or Fragment Based Screening documentation.
The type of the parameter INTSCL changed from float to double (Knowledge Base #Item
14009). So all AU programs evaluating the parameter INTSCL must be changed and supply
the address of a double variable as 2nd argument of FETCHPAR / FETCHPARS.
e.g.
float intscl;
FETCHPARS("INTSCL", &intscl)

must be changed to

double intscl;
FETCHPARS("INTSCL", &intscl)
Omitting this adaption will cause runtime errors during execution of the AU program.
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6.4.2.6 Automation

• Option to hide the sref message: “reference peak not found default calibration done” from
Preceding Experiments->Remarks

• Assure-SST allows for setting of the Shim routine individually for all SST experiments
• New Dual Receive Composite Experiment Definitions: COSY, HSQC and TOCSY
• New languages available: Chinese, French, Italian, Korean, Portuguese

BEST-NMR with Bruker LiquidHandler 215 no more available in TopSpin 4.0.3

6.4.2.7 Pulse Programming

• Bracket operator for lists now working (e.g. powerList[2]:f1)
• Shape lists now available (list<shape>)
• Modification of RG now possible from within the pulse program using a list<receiverGain>

Please refer to the Pulse Programming Manual for further details (“Receiver Gain Lists”).

6.4.2.8 GxP Operation

In contrast to previous TopSpin versions, the login dialog does not offer a list of known user
IDs in a list for selection. The dialog requires the user to enter both a valid user ID and its
corresponding password. In case of invalid input the error message is intentionally unspecific.
As a result the login process does not disclose known user IDs, and failed login attempts do
not disclose whether a user ID really exists or not. This change had been introduced with
TopSpin 4.0.2 already but was not included in the Release Letter.
Topspin maintains a log of startup, shutdown, and internal login/logoff events. This file is
protected against unauthorized changes by checksums for every entry. The consistency of
the complete log is checked with any new entry made, and inconsistencies logged as a
warning message.
The content has been improved to now specifying a “system.user” and “intern.user” for every
entry, where “system.user” states the currently used account of the operating system
“intern.user” states the TopSpin internal user ID which can be different. If the internal login
functionality has not been used, intern.user will be logged as “unknown”.
In case a login attempt has failed e.g. due to unknown user ID or wrong password specified,
the entry only uses the entered user ID but not any resolution against existing user IDs. So
failed login attempts do not disclose whether a specified user ID really exists or not.
TopSpin data may be viewed using the “-developer” option at TopSpin startup. No license is
required for this case.
For the sole review of data sets and audit logs, TopSpin can be started in a review-only mode
which does not require an active product license. This is performed by using the command
line option “-developer” at start-up:

• On Windows, click on Start, select Bruker NMR Software / Bruker 4.x Utilities / Command
Prompt, then enter “topspin -developer”

• On Linux / macOS, open a shell, change to the installation directory of this version, then
enter “./topspin -developer”
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6.5 TopSpin 4.0.4

6.5.1 Bug Fixes

The following topics describe the major fixes which come with TopSpin 4.0.4.
The topics are named by item numbers, referring to the Bruker knowledge base. For detailed
information about the different items, please look up the Bruker knowledge base. The Bruker
knowledge base can be found on the Bruker Web Server under the following address:
http://www.bruker.com/bkb_access.html?&no_cache=1

Please note: You need a login to access this section. If you haven’t registered yet, please
register here:
https://www.bruker.com/about-us/register.html
If you are already connected to the internet and if you have access to the Bruker knowledge
base, you can then open the respective item by entering the item number in the appearing
window.

• Item #14460 Barcode Operation: Experiments may be performed on an incorrect sample

• Item #14459 topshim fails with THF-H8 solvent

• Item #14458 Sample Express Lite not very suitable for Easy Setup Mode

• Item #14441 proc_1dglp doesn’t work with a data path containing a blank character

• Item #14432 Spreadsheet import only increments expno by 1

• Item #14423 INTSCL is wrongly listed as a float in the AU programming manual

• Item #14391 TopShim performs bad after changing from 4.0.1 to 4.0.2 on magnet with
inversed polarity

• Item #14388 Emails of zip/jdx files fail if multiple sequential spaces in name

• Item #14383 No/wrong save of the color attributes in plot layouts

• Item #14382 Error messages appear in quick succession - Automation window inoperative

• Item #14378 Automatic spreadsheet import reports fake error

• Item #14373 pulseprogramming: reset:fx:fy does not work as expected

• Item #14371 Print or export to PDF/PS of multiple display output is missing dataset names

• Item #14369 Setting both night mode and start time hangs IconNMR

• Item #14367 wobb overwrites fq1list

• Item #14362 Slashes removed from Disk paths

• Item #14356 Spreadsheet import dialog will not open

• Item #14351 Experiment setup using spreadsheets imports always until last line

• Item #14348 Unresponsive Parameters, Analysis and Title popup windows in Experiment
List

• Item #14346 Error message containing: AutoSet_Find_CheckAllAveragingCompleted
appears

• Item #14345 Automation freezes with hourglass and has to be killed

• Item #14335 Originator item names with : at the end do not work

• Item # 14334 Missing box for path definition of structure file in plot layout

http://www.bruker-biospin.com/bkb_access.html?&amp;amp%253Bamp%253Bno_cache=1
http://www.bruker.com/bkb_access.html?&no_cache=1
https://www.bruker.com/about-us/register.html
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• Item #14325 AssureSST bad window path name error message

• Item #14320 File->Import Configuration does not set various configuration items

• Item #14319 Solvent/Probe dependent lock program settings lost

• Item #14317 Archiving may overwrite previously archived directory

• Item #14316 Invalid command name AutoSet_UpdateHistoryFile - Run crashes when
processing switched off

• Item #14297 MWM lockdown mode not recognized

• Item #14295 Wrong user created when using the domain

• Item #14031 Read/Write parameter sets for multi-RX experiments

• Item #14030 Copy multi-RX data sets

• Item # 13601 edprobe connection changes might lead to incorrect default routing

6.5.2 New Features

6.5.2.1 User Interface

Sizes of fonts and icons of the TopSpin General User Interface can be modified easily by
clicking Preferences | Windows settings | All in One Fonts & Icon size. This improves
TopSpin’s behavior on high resolution displays.

Please note that modified sizes of fonts and icons are available after restart of TopSpin.
The new tab Command Line History, located in the menu bar of the Data Browser window,
shows the history of previously entered commands.
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The new tab Status Message History, located in the menu bar of the Data Browser window,
shows the history of TopSpin’s status messages.

6.5.2.2 Acquisition

The J-compensated adiabatic pulses are now calculated automatically using the following
synatx:
wurst(200 ppm; Jcomp) – for adiabatic pulses immediately after the 180H pulse
wurst(200 ppm; L2H, Jcomp) – for adiabatic pulses immediately before the 180H pulse
Users can define their own J vs CS correlation coefficients using the C2 (A) and C3 (B)
constants.
The optimum setting of the J-coupling is calculated provided the following pulse program
syntax is used:
“d2 = 0.5/cnst2” ;JCOMP – indicates that cnst2 to be adjusted.
The new/edc command is now available for Multi-Receiver handling according to the
selected experiment type.
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The dialog offering the list of all parameter sets can be opened by using the Select button.

Entering “DR_*” in the Find file names field can be used to filter/display the Multiple receiver
parameter sets.
Select the desired parameter set and close the dialog by clicking the button Set selected
item in editor.
Then edc dialog reappears. The name of the Multiple receiver parameter sets and the
number of datasets (receivers) will be set automatically.
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When clicking OK the multiple receiver data set will be created, parent with EXPNO=2, child
with EXPNO=3.

The commands rpar and wpar are both supporting multi receiver handling.
The AU program iexpno is supporting multi receiver handling too.
In edprosol pulse width and pulse power can now be printed for all nuclei at once with File |
Print | 90 deg. Pulses.
Up to now pulse width and pulse power could only be printed for the selected nuclei.
edprobe: The default values for non-PICS HRMAS-probes have been improved.
It is now possible to wobble more than one channel simultaneously. The following wobble
commands are now available:

• wobb: standard wobble as before.
• wobb f<x> f<y>: simultaneous wobbling of channels F<x> and F<y> in edasp. For

WBSW the respective array entries are used, i.e. WBSW[0] for channel F1, WBSW[1] for
channel F2 etc. If WBSW[x] is 0 then WBSW[0] is used as a fallback.

• wobb all: simultaneous wobbling of all channels in edasp using the respective WBSW
entries.
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• wobb wbst 1024 f1 wbsw 4.5 f2 wbsw 60: simultaneous wobbling of channels f1 and f2
with WBST=1024, and f1 using 4.5MHz and f2 using 60MHz for WBSW

6.5.2.3 Processing

The functionality to "Collect & Save LogFiles (savelogs)" has been revised for TopSpin 4.0.4.
The command can be started form Manage | Commands or by entering savelogs.

savelogs is mainly used for debugging purposes. This tool will collect support information
about the current TopSpin installation (log and configuration files, by default no NMR data)
and allows you to transfer it to Bruker. It offers a new "Comments" field to enter a description.
Please enter here a description of your issue. If you are already in contact with Bruker, give a
reference to a mail or phone call or ticket number.
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The file transfer process has been changed from ftp to a https secured transfer method.
Please note that usually, you should get the "Support token" from Bruker, if not, please use a
descriptive text (e.g. your name and the name of your institution or company).
If issues with spectra are observed, please add the respective NMR data with the "Additional
files or directories" option.

6.5.2.4 Automation

• Use sti <holder> in TopSpin to insert current data set in the automation queue at position
<holder>

• SmartDriveNMR: Data sets only archived when really completed
• InsightMR: Allow use of Dual-Receive Experiments for experiment iteration
• New language: Spanish (also available in TopSpin 4.0.3)

6.5.2.5 Pulse Programming

• Bracket operator for lists now working (e.g. powerList[2]:f1)
• Shape lists now available (list<shape>)
• Modification of RG now possible from within the pulse program using a list<receiverGain>

Please refer to the Pulse Programming Manual for further details (“Receiver Gain Lists”).
Multi-dimensional AV Neo datasets contain the status parameter FnILOOP in each non
acquisition dimension which is set according to the inner loop construct in the pulse program
to:
0: no mc program,

1: no inner loop,

n > 1: number of inner loops.

In data acquired with inner-loop pulse programs without mc-syntax all acquisition status
parameters FnILOOP = 0 and the number of inner-loops must be specified when calling the
split AU programs.

6.5.2.6 GxP Operation

The updated 21 CFR Part 11 manual contains information about the TopSpin default
configuration. In particular, it explains the meanings of the default Bruker users nmr and
nmrsu. Also some explanatory text fragments have been corrected and improved.
In TopSpin's login log file, the current operating system user and TopSpin's internal user are
logged for startup, shutdown, login, and logoff operations. If no internal user has been used, it
is now logged as "intern.user=unused".
In previous versions this has been logged as "intern.user=unknown" which may be
misunderstood as indication of a problem when reviewing the login log file e.g. during GxP
audits.
A password initially assigned to new accounts expires immediately. This is in order to force
any new user to assign a new secret password upon first login.
Some users reported that the execution of command lockdataset does not restrict the file
permissions as expected for the affected data set. This happens when the data set is located
on a network file system (e.g. NFS, Samba, Windows shared folder, NAS instances) instead
of the local file system. Please note that the functionality can be ensured for data sets stored
on a local file system only. By design, network folders obscure the storage technology behind
a shared directory object and may perform mappings of visible permissions to real
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permissions on the target system. This mechanism is intransparent for the initiating software
application. Therefore lockdataset cannot ensure that the intended access restrictions are
applied at the remote location correctly.
The functionality of the Central Audit File is currently offered for Windows installations only.
An adaption to Linux and macOS environments is work in progress and will be available
soon.

6.5.2.7 Analysis

The FBS software for Fragment Based Screening analysis offers new features: spectra color
management and mixture browsing from the spectra multiple display. Please note the
backward and forward compatibility between this release and the previous releases in TS3
and TS4. A new license is needed to run this software upgrade, please contact us at
fbs@bruker.com.
The current version is CMC-se 2.5.5. In addition to several bug fixes, an implementation of
the data export in NMReData format (www.nmredata.org) is introduced. This novel format
contains assigned molecular structure. The assignment includes 2D correlations such as
HMBC or HMBC. CMC-se projects can now be exported to NMReData or NMR Records.
The latter also includes all spectra.

6.5.2.8 AU Programming

Therefore, some new functions were included which can be called from an au-program:
• int getPeakDimension(): returns the dimensionality of the considered peak list,

returns -1 if the peak list was not read correctly
• double getPeakFreqHzForDim(unsigned int peakIndex, unsigned int
dimIndex): returns the frequency of a peak specified by peakIndex in Hz for a specific
dimension with index dimIndex (range from 0 to getPeakDimension() – 1), returns
-1 if the peak list was not read correctly or one of the indices are out of range

• double getPeakFreqPPMForDim(unsigned int peakIndex, unsigned int
dimIndex): the same as getPeakFreqHzForDim, but result in PPM

• int getPeakAddressForDim(unsigned int peakIndex, unsigned int
dimIndex): returns the address of a peak specified by peakIndex for a specific
dimension with index dimIndex (range from 0 to getPeakDimension() – 1), returns
-1 if the peak list was not read correctly or one of the indices are out of range

The corresponding old functions for the one-dimensional case (the respective functions
without the ForDim –extension) are still present, they just call their new counterparts with
dimIndex=0.
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7 Contact

Manufacturer
Bruker BioSpin GmbH
Silberstreifen 4
D-76287 Rheinstetten
Germany
http://www.bruker.com

WEEE DE43181702

NMR Hotlines
Contact our NMR service centers.
Bruker BioSpin NMR provides dedicated hotlines and service centers, so that our specialists
can respond as quickly as possible to all your service requests, applications questions,
software or technical needs.
Please select the NMR service center or hotline you wish to contact from our list available at:
https://www.bruker.com/service/information-communication/helpdesk.html

Phone: +49 721-5161-6155
E-mail: nmr-support@bruker.com

http://www.bruker.com
https://www.bruker.com/service/information-communication/helpdesk.html
mailto:nmr-support@bruker.com
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Bruker Corporation

info@bruker.com
www.bruker.com

Order No: H90088TR4-05
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